
Lesson Skill Matrix

Skill Exam Objective Objective 

NumberSetting Up a Mail Merge Perform mail merges.

Manage recipient lists.

Insert merged fields.

Preview merge results.

3.3.3

3.3.4

3.3.5

3.3.6

Software Orientation

Mailings Tab

You use commands on the Mailings tab to perform mail merges, as well as to create envelopes and 

labels for a group mailing (see Figure 7-1).

Figure 7-1

Mailings tab

Performing Mail Merges
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Mail merges are useful for creating multiple documents that have the same basic 

content and personalizing them with unique information from a data source—for 

example, a form letter sent to multiple customers using different recipient names and 

addresses. You can use mail merges for internal and external correspondence such as 

memoranda, labels, invitations, and more. The mail merge document contains the same 

information that everyone will receive. The individuals receiving the document are 

located in a data source, which is the list of recipients, and contains information for each 

individual with variable data, such as the person’s first and last name, address, city, state, 

zip code, phone number, and so on. You can create the data source as a Word table, in 

which Word provides the fields and you type the data in them. You can also customize 

the fields to fit your document. Word also supports the use of other programs for the 

data source, such as Excel workbooks, Access tables or queries, or Outlook contacts lists.

Setting Up a Main Document Manually

You can begin working with Mail Merge by typing your letter and then selecting a data 

source. You can use an existing data source, create your own data source list by typing 

your recipients' information, or use an Outlook address book for your contact 

information. You don't need to have a database program installed on your computer 

because Word makes it easy to create your list of recipients. You can create a table in 

Word in which the fields are already identified for you and easy to customize. After 

setting up your document, you can preview your results and check for errors using the 

tools available in the Preview Results group and then perform the merge. In this 

exercise, you create a document, type information, insert an existing data source, insert 

the address block and greeting line, check for errors in the document, preview the 

letters, and perform the merge.

Step by step           Set Up a Main Document Manually

On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge

drop-down arrow to display the Start Mail Merge menu (see Figure 7-2).

1.

GET READY. Before you begin these steps, LAUNCH Microsoft Word and CREATE a 

new blank document.

Setting Up a Mail Merge
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Figure 7-2

Start Mail Merge menu

Choose Letters.2.

PAUSE. LEAVE Word open to use in the next exercise.

Step by step           Select Recipients

In the Start Mail Merge group, click the Select Recipients button to display the 

menu as shown in Figure 7-3.

1.

Figure 7-3

Select Recipients menu

Take Note

Notice that some of the commands on the Ribbon are grayed out, and are 

therefore not available until you open a data source file.

Select Use an Existing List. The Select Data Source combo box appears. Browse to 

your flash drive and navigate to your data files for the lesson folder.

2.

OPEN the Student List (Access) database from the lesson folder. After opening the 

data source file, most of the commands on the Mailings tab on the Ribbon become 

active (see Figure 7-4). When selecting a data source file, the file can be a database, 

an Excel spreadsheet, a table in Word, or an Outlook contacts list.

3.

GET READY. USE the document that is open from the previous exercise.
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Figure 7-4

Fully activated Mailings tab on the Ribbon

At the insertion point, type March 19, 20XX and then press the Enter key twice. By 

default, the Spacing After is set to 8 pt. Later, you will format the document to an 

appropriate business format.

4.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step           Prepare Merge Fields

On the Mailings tab, in the Write & Insert Fields group, click the Address Block 

button. The Insert Address Block dialog box appears (see Figure 7-5).

1.

Figure 7-5

Insert Address Block dialog box

Notice that the street address is missing in the Preview area. Click the Match Fields 

button. The Match Fields dialog box appears (see Figure 7-6). 

2.

GET READY. USE the document that is open from the previous exercise.
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Figure 7-6

Match Fields dialog box

To correct the error, select the drop-down arrow for the Address 1 field and then 

select Address Line. Click OK to close the Match Fields dialog box. The address 

block shown in the Preview area now includes the address line. 

3.

Click OK to accept the address settings with the correction and close the Insert 

Address Block dialog box. 

4.

Press Enter once.5.

On the Mailings tab, in the Write & Insert Fields group, click the Greeting Line 

button. The Insert Greeting Line dialog box appears (see Figure 7-7).

6.
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Figure 7-7

Insert Greeting Line dialog box

For the Greeting Line format, use the salutation Dear and then add the default 

name where Joshua Randall Jr. is shown. Change the comma to a colon.

7.

Click OK. Press Enter once.8.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step           Write the Letter

Type the following letter (see Figure 7-8):

The president of the college, Dr. Jose A. Torres, is extending an invitation to all 

students who received scholarships for the next academic semester. The Graphic 

Design Institute recognizes all students for their academic excellence. A reception 

is being held in your honor on March 29 at 12 noon in the President’s Conference 

Room 19. [Press Enter once.]

Please confirm your attendance by calling 915-999-9999. [Press Enter once.]

Regards, [Press Enter twice.]

Jerry Wright [Press Shift+Enter to insert a line break.]

Scholarship Committee Chair

1.

GET READY. USE the document open from the previous exercise.
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Figure 7-8

Mail Merge letter

PAUSE. LEAVE the document open to use in the next exercise.

Step by step           Preview the Document

In the Preview Results group, click the Preview Results button. The first recipient 

appears, as shown in Figure 7-9. 

1.

Figure 7-9

Preview letter

Click the Next Record arrow button to preview the letters for the other recipients.2.

Disable Preview Results by clicking the Preview Results button again.3.

Place the insertion point in the «Address Block» field. On the Home tab, in the 

Paragraph group, click the Line and Paragraph Spacing button and then click 

4.

GET READY. USE the document open from the previous exercise.
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Paragraph group, click the Line and Paragraph Spacing button and then click 

Remove Space After Paragraph. 

Place the insertion point in the «Greeting Line» field. On the Layout tab, in the 

Paragraph group, change the Spacing Before value to 6 pt. The Spacing Before is 

increased by 6 pts, separating the address block and greeting fields.

5.

On the Layout tab, in the Page Setup group, click the Margins button and then 

click Custom Margins. The Page Setup dialog box appears, with the Margins tab 

selected. Type 2 in the Top box to change the top margin. Click OK.

6.

On the Mailings tab, in the Preview Results group, click the Preview Results button

to view the formatting changes you made to the document (see Figure 7-10). After 

you finish your review, disable Preview Results.

7.

Take Note

Organizations use customized letterheads to print their letters. The top margin 

must be adjusted to avoid text printing over the organization's logo.

Figure 7-10

Preview results

SAVE the main document as Reception Letter in the lesson folder on your flash 

drive. Saving the main document as a separate document enables you to merge 

with a new data source file, such as when you need to use the same letter again, 

but with a different recipient list. When you open a main document that contain 

field codes, Word asks you for the data source file.

8.

Take Note

The main document is the document that contains the body of the letter as well as 

the Address Block and Greeting Line merge codes.

PAUSE. LEAVE the document open to use in the next exercise.
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PAUSE. LEAVE the document open to use in the next exercise.

Take Note

Once the main document has been set up, you can format at the beginning of the mail 

merge process.

Executing A Mail Merge

The final steps in a mail merge are to check for errors, preview the merge, and finalize 

the merge. The Check for Errors feature mimics the merge before you complete the final 

merge and print process. If there is an error, you can correct it in the main document. 

For example, if you used the Insert Merge Field button and forgot to insert the field for 

city, you would see the error in the document. To correct the error, make sure you do 

this in the main document.

Step by step           Check for Errors

In the Preview Results group, click the Check for Errors button. The Checking and 

Reporting Errors dialog box opens (see Figure 7-11).

1.

Figure 7-11

Checking and Reporting Errors dialog box

Select the first option, Simulate the merge and report errors in a new document.2.

Click OK.3.

A message box appears, indicating that No mail merge errors have been found in 

Reception Letter. Click OK.

4.

GET READY. USE the Reception Letter document that is open from the previous 

exercise.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step           Complete the Merge

In the Finish group, click the Finish & Merge button to display the Finish & Merge 

menu (see Figure 7-12).

1.

GET READY. USE the Reception Letter document that is open from the previous 

exercise.
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Figure 7-12

Finish & Merge menu

All: Merges all letters to a new document

Current record: Merges only the record on which your insertion point is 

positioned



From and To: Merges a range of records, according to the values you specify 

in the From and To text boxes.



Select Edit Individual Documents. The Merge to New Document dialog box opens as 

shown in Figure 7-13. This dialog box presents the following options:

2.

Figure 7-13

Merge to New Document dialog box

Select the From/To option. 3.

In the From text box, type 3, and in the To text box, type 5. 4.

Click OK. Word creates a new document that contains separate letters for records 3 

through 5 (see Figure 7-14). Scroll through the document to preview that the 

document is ready to print.

5.
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Figure 7-14

Sample merged letter

SAVE the merged document as Merged Reception Letter in the lesson folder on 

your flash drive and then CLOSE the file.

6.

Make sure Preview Results is disabled and then CLOSE the main document 

Reception Letter. A message box appears, asking, Do you want to save changes 

made to Reception Letter? Click SAVE.

7.

PAUSE. LEAVE Word open for the next exercise.

When you save the main document with the field codes, you will be able to return to 

your document and recipient list and use the tools available in the Mailings tab. You can 

also edit the list of recipients or open another data source to send the same letter to 

another group of recipients.

Using the Step-by-Step Mail Merge Wizard

It's a good idea to learn the various steps of a mail merge by performing them manually, 

but if you want to make sure that you complete all of the required tasks, you can use 

the Step-by-Step Mail Merge Wizard to walk you through the process.

Step by step           Use the Step-by-Step Merge Wizard

On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge

drop-down arrow and then select Step-by-Step Mail Merge Wizard. The wizard 

appears in a separate pane to the right of your document, displaying the Select 

Document Type page (see Figure 7-15).

1.

GET READY. CREATE a new blank document.

   Lesson 7 Page 11    



Figure 7-15

Select document type page in the Step-by-Step Mail Merge Wizard 

Take Note

The Step-by-Step Mail Merge Wizard provides an alternate method for completing 

the same tasks you performed during the manual mail merge setup, earlier in this 

lesson. In some cases, the wizard uses the same dialog boxes as the manual 

procedure, while others are different. 

Select the type of document you want to create, as you did earlier in the Start Mail 

Merge menu, and then click the Next: Starting Document link at the bottom of the 

page. The Select Starting Document page appears (see Figure 7-16). On this page, 

you specify whether to work with the currently open document, open another 

existing document, or create a new one from a template. 

2.
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Figure 7-16

Select starting document page in the Step-by-Step Mail Merge Wizard 

Select a starting document option and then click the Next: Select Recipients link. 

The Select Recipients page appears (see Figure 7-17). On this page, you specify 

whether you want to use an existing file as your data source, use your Outlook 

contacts, or type a new list of recipients. Selecting the Use an existing list option 

displays the same Select Data Source combo box you saw earlier in the Select 

Recipients procedure. The Edit recipient list link opens a Mail Merge Recipients

dialog box, in which you can search for and select individual records in your data 

source.

3.

   Lesson 7 Page 13    



Figure 7-17

Select recipients page in the Step-by-Step Mail Merge Wizard 

Select a data source for your recipients list and then click the Next: Write your 

letter link. The Write your letter page appears (see Figure 7-18). On this page, while 

typing your letter, you can use links to insert an address block, a greeting line, and 

other information from your data source, just as you did earlier using the buttons 

in the Write & Insert Fields group on the ribbon. As in the manual procedure, you 

can correct the mapping of the data fields to your inserts, if necessary, using the 

Modify Address Block dialog box and the Modify Greeting Line dialog box.

4.
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Figure 7-18

Write your letter page in the Step-by-Step Mail Merge Wizard 

When you have finished creating your letter, click the Next: Preview your letters

link. The Preview your letters page appears (see Figure 7-19). From this page, you 

can display each of the letters your merge will create, using the arrow buttons to 

scroll through them. You can also search for a specific recipient and edit your 

recipient list, if necessary.

5.
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Figure 7-19

Preview your letters page in the Step-by-Step Mail Merge Wizard 

When you have finished previewing your letters, click the Next: Complete the 

merge link. The Complete the merge page appears (see Figure 7-20). On this page, 

you can send the merged letters directly to your printer or click Edit individual 

letters to open the Merge to New Document dialog box you saw earlier. As before, 

this enables you to create a new document containing some or all of your merged 

letters.

6.
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Figure 7-20

Complete the merge page in the Step-by-Step Mail Merge Wizard 

Once you have completed the six steps of the wizard, you can save your original 

main document for later use with a different recipient list or save the merged 

document containing all of your letters.

7.

CLOSE the Mail Merge pane. 8.

PAUSE. CLOSE the document. LEAVE Word open for the next exercise.

Merging a Document with Different Data Sources

Previously in this lesson, you learn to perform a mail merge using a Word document and 

an Access database as the data source. However, you can use other data sources in a 

mail merge, including Word tables, Excel workbooks, and Outlook contact lists. Each of 

these different formats includes fields—name, address, city, state, zip code, and so on. If 

the format of the data source is not correctly recognized by Word, then you can use the 

Match Fields button to correct any errors. 

In the next exercise, you learn to merge an existing letter with different data sources, 

both manually and by using the Step-by-Step Mail Merge Wizard. 

   Lesson 7 Page 17    



Step by step           Merge a Letter with a Table

On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge

button. Choose Letters.

1.

In the Start Mail Merge group, click the Select Recipients button to display the 

menu.

2.

Select Use an Existing List. The Select Data Source combo box appears. Locate your 

flash drive and navigate to your data files for the lesson folder.

3.

OPEN the Student Listing data source file from the lesson folder. The Student 

Listing file is a Word document containing a table with fields as headers and 

records displayed within the table.

4.

In the Scholarship document, at the insertion point, type November 28, 20XX. Press 

Enter twice.

5.

In the Write & Insert Fields group, click the Address Block button to open the Insert 

Address Block dialog box. Notice that the preview area does not display the street 

address.

6.

Click the Match Fields button to correct the problem. The Match Fields dialog box 

appears, as shown in Figure 7-21.

7.

Figure 7-21

Match Fields dialog box

Under Required for Address Block, Address 1 displays as Not Matched because the 

field heading in the table is listed as Address Line and does not directly match the 

8.

GET READY. OPEN the Scholarship document from the lesson folder.
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field heading in the table is listed as Address Line and does not directly match the 

field name in the address block in Word.

Click the drop-down arrow next to Address 1, select Address_Line, and then click 

OK to close the dialog box. Review the preview area and notice that the problem 

has been corrected and the address is now displayed correctly.

9.

Click OK to close the Insert Address Block dialog box. Press Enter once10.

Click the Greeting Line button. The Insert Greeting Line dialog box appears. 11.

Change the punctuation to a colon and then click OK.12.

Click the Preview Results button and notice that the spacing in the Address Block 

needs to be formatted correctly. Click the Preview Results button again to see the 

field codes.

13.

Select the «Address Block» and, on the Layout tab, in the Paragraph group, 

decrease the Spacing Before setting to 0.

14.

In the Page Setup group, click the Margins button. The Page Setup dialog box 

appears, with the Margins tab selected. 

15.

Change the top margin to 2" and the left and right margins to 1". Click OK to close 

the dialog box. Preview the results before finishing the merge.

16.

On the Mailings tab, in the Finish group, click the Finish & Merge button and then 

click Edit Individual Documents. The Merge to New Document dialog box appears.

17.

In the Merge to New Document dialog box, keep the defaults and then click OK. A 

new Word document appears containing individual letters for all of the recipients 

in the data source.

18.

SAVE the document as Merged Academic Honors Scholarship in the lesson folder 

on your flash drive and then CLOSE the file.

19.

Make sure you turn off Preview Results so that the field codes are displayed in the 

main document. 

20.

SAVE the main document as Academic Honors Scholarship Letter in the lesson 

folder on your flash drive and then CLOSE the file. 

21.

PAUSE. LEAVE Word open for the next exercise.

In the next exercise, you learn to merge a letter with an Excel data source using the 

wizard, Ribbon, and insert field codes to complete the mail merge process.

Step by step           Merge a Letter with Excel

On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge

button, and then select Step-by-Step Mail Merge Wizard to open the Mail Merge 

pane.

1.

In the Select document type section, Letters is the default. Click Next: Starting 

document.

2.

Select the Use the current document option and click Next: Select recipients to 

advance to the next step.

3.

In the Select recipients section, click Browse and, in the Select Data Source combo 

box, locate the Student List (Excel) file in the lesson folder on your flash drive. 

4.

GET READY. OPEN the Scholarship document from the lesson folder.
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box, locate the Student List (Excel) file in the lesson folder on your flash drive. 

Click Open. The Select Table dialog box appears (see Figure 7-22).5.

Figure 7-22

Select Table dialog box

Take Note

The student files for this lesson include two source files containing recipient data. 

One is a Microsoft Access database called Student List (Access) and one is a 

Microsoft Excel spreadsheet called Student List (Excel). The main difference between 

the two in the mail merge process is the dialog boxes that appear after you select 

the recipient file. Excel files generate a Select Table dialog box first, in which you 

can select a specific table from the workbook, if it contains more than one. Access 

files proceed directly to the Mail Merge Recipients dialog box you saw earlier in the 

lesson. Be sure to select the correct file for each of the exercises in this lesson.

The selected state of the First row of data contains column headers checkbox 

indicates that Word automatically recognizes the column headings in the selected 

worksheet. Click OK. The Mail Merge Recipients dialog box appears.

6.

Notice that in the Data Source box, the Student List (Excel) file name appears. Click 

OK to close the dialog box.

7.

CLOSE the Mail Merge pane.8.

Position the insertion point at the beginning of the document and then type the 

current date. 

9.

Press Enter twice.10.

Click the Insert Merge Field button to open the Insert Merge Field dialog box (see 

Figure 7-23).

11.
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Figure 7-23

Insert Merge Field dialog box

Select First Name and then click the Insert button to insert the «First_Name» field 

code in the document.

12.

Click the Close button to close the Insert Merge Field dialog box. 13.

Press the spacebar once and then click the Insert Merge Field drop-down arrow to 

display the fields (see Figure 7-24). This is another way to insert field codes in a 

document.

14.

Figure 7-24

Fields menu

Select Last_Name to insert the «Last_Name» field code in the document.15.

Press Enter to create a blank line.16.

Click the Insert Merge Field drop-down arrow and then select Address_Line to 

insert the «Address_Line» field code in the document.

17.

Press Enter to create a blank line.18.

Click the Insert Merge Field drop-down arrow and then select City to insert the 

«City> field code in the document.

19.
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«City> field code in the document.

Type a comma after «City» and then press the spacebar once.20.

Click the Insert Merge Field drop-down arrow and then select State to insert the 

«State» field code in the document. Press the spacebar once.

21.

Click the Insert Merge Field drop-down arrow and then select ZIP_Code to insert 

the «ZIP_Code» field code in the document.

22.

Press Enter once to create a blank line.23.

Type Dear and then press the spacebar once.24.

Click the Insert Merge Field drop-down arrow and then select First_Name to insert 

the «First_Name» field code in the document.

25.

Press the spacebar once.26.

Click the Insert Merge Field drop-down arrow and then select Last_Name to insert 

the «Last_Name» field code in the document.

27.

Type a colon after «Last_Name». 28.

Notice the excess spacing between the lines of the field codes. To correct this, 

select «First_Name» through «ZIP_Code».

29.

On the Layout tab, in the Paragraph group, set the Spacing Before value to 0,

change the top margin to 2", and then change the left and right margins to 1". 

Preview the results before finishing the merge.

30.

Click the Finish & Merge button and then click Edit Individual Documents.31.

In the Merge to New Document dialog box, keep the defaults and then click OK. A 

new document appears, with the merged document displaying all of the records in 

the worksheet.

32.

SAVE the document as Merged Academic Scholarship in the lesson folder on your 

flash drive and then CLOSE the file.

33.

Make sure you turn off the Preview Results so that the field codes are displayed in 

the main document and close the Mail Merge pane. 

34.

SAVE the main document as Academic Scholarship Letter in the lesson folder on 

your flash drive and then CLOSE the file. 

35.

STOP. CLOSE Word.
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Multiple Choice

Mergea.

Mailingsb.

Mail Mergec.

Insertd.

Which tab contains the commands used to perform mail merges?1.

Download from an online directorya.

Type a new listb.

Use an existing listc.

Use your Outlook contactsd.

Which of the following is not an option for selecting a list of recipients for the mail 

merge?

2.

An address validator.a.

A form letter.b.

A data source.c.

A website.d.

To merge information into your main document, you must first connect the 

document to which of the following?

3.

When the main document is saveda.

When recipients are selectedb.

When merge fields are insertedc.

When the mail merge is performedd.

When mail merge fields have been inserted into a document, Word will 

automatically replace them with information from a data source when which of the 

following occurs?

4.

All the data in an Excel spreadsheeta.

Any other open fileb.

The default return address for Wordc.

The main document's connection to the data sourced.

When you save the main document, you also save which of the following?5.

Select the best response for the following statements.

True/False

Circle T if the statement is true or F if the statement is false.

T F It is a good practice to check for errors before completing the merge process.1.

T F Word makes the it easy to use an existing list of recipients in a new mail 

merge document. 

2.

T F The Address Block also includes the Greeting Line.3.

T F Fields correspond to the column headings in an Excel data source.4.

T F You cannot preview a document before merging.5.

Knowledge Assessment
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Project 7-1: Performing a Mail Merge

In this project, you will complete the mail merge to the list of professional members of 

the local business community volunteering to judge a state contest for high school 

business students.

A message box appears, informing you that data from your database will be placed 

in the document. Click Yes.

1.

On the Mailings tab, in the Finish group, click Edit Individual Documents. The Merge 

to New Document dialog box appears. 

2.

Leave the default option All option selected and then click OK. A new document 

opens containing all four merged letters.

3.

SAVE the merged document as 7-1 Judges Merged in the lesson folder on your 

flash drive and then CLOSE the file.

4.

SAVE the main document as 7-1 Judges Main Letter in the lesson folder on your 

flash drive and then CLOSE the file.

5.

GET READY. OPEN Judges Main Letter from the data files for this lesson.

PAUSE. LEAVE Word open for the next project.

Project 7-2: Creating a Mail Merge Document 

The marketing representative, Isabel Diaz, has asked you to prepare a short letter to the 

members of a committee, reminding them of a deadline. In this project, you will use the 

Step-by-Step Mail Merge Wizard to create the merge document.

Set up the letter as the main document for a mail merge.1.

Select the Committee Members file as the recipient's list from the lesson folder.2.

Type May 29, 20XX under the image and then press Enter.3.

Insert the Address Block and Greeting Line. Use the colon in place of the comma.4.

Place your insertion point in the Address Block, and on the Home tab, in the 

Paragraph group, click the Line and Paragraph Spacing button and then select 

Remove Space After Paragraph. 

5.

Place your insertion point in the Greeting Line. In the Paragraph group, click the 

Line and Paragraph Spacing button and then select Add Space Before Paragraph.

6.

On the Mailings tab, click Check for Errors, select the Simulate the merge and 

report errors in a new document option, and then click OK.

7.

Dismiss the results message and then click the Preview Results button.8.

Click Finish & Merge and Edit Individual Documents and then click OK.9.

SAVE the merged document as 7-2 Advertising Merged Letter in the lesson folder 

on your flash drive and then CLOSE the file.

10.

SAVE the main document as 7-2 Advertising Main Letter in the lesson folder on 

your flash drive and then CLOSE the file.

11.

GET READY. OPEN the Advertising Letter document from the lesson folder.

Projects
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your flash drive and then CLOSE the file.

CLOSE Word.
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